Assignment 1, 8/2/2006, 8:43 AM

KOS 1110 Computers in Science

Assignment 1 - Questions in Excel

1. What is a spreadsheet program? How does it differ from a word processing program? 

Spreadsheet program are in form of laid out in rows and columns, work with numbers and can perform calculations. It is differ from a word processing program which has different layout, and its way of functioning. In a word processing program users operate on a blank, plain white space while in a spreadsheet program is presented to users in rows and columns of cell. A word processing spreadsheet program cannot be used to perform calculations like spreadsheet program.
2. What is the difference between a worksheet and a workbook?
Worksheet is a “single-sheet” or also known as a spreadsheet, is used to store and work with data. A workbook is consists of multiple worksheets represented by Tabs at the bottom of the Excel screen, which is used to store numerous information in it.
3. How do you copy and move cell contents? 

a) Select the cell contents. 
b) From the Menu Bar, select Edit then Copy or simply click Copy icon from the Standard toolbar.

c)  Then move to the cells where the information is to be copied.
d)  Then select Edit and Paste from the Menu Bar simply click Paste icon from the Standard toolbar.

4. How do you use the fill handle to copy contents of cells and to create a sequence? What type of sequences can be created using the fill handle?  

We can use the fill Handle Method to copy contents of cells by:

a) Moving the Mouse Pointer over the square in the lower right corner of the selected cell/cell range. 
b) Then mouse pointer changes to a cross-hair symbol +. 
c) Hold down the left mouse button and drag to copy and release the mouse button.

Using fill handle to create a sequence:

a) Select at least two cells that contain the starting values for the trend. If we want to increase the accuracy of the trend series, select more starting points.

b) Drag the fill handle in the direction you want to fill with increasing or decreasing values. 
Type of sequences can be created using the fill handle are simple linear trend and exponential growth.

5. How do you create custom headers and footers? 

To create custom headers and footers:

a) Click the worksheet that is to be inserted the header and footer.    

b) Choose Header and Footer from the View menu.

c) Choose the header or footer in the Header or Footer box.

d) Click Custom Header or Custom Footer.

e) Click in the Left section, Center section, or Right section box, and then click the buttons to inserts the header or footer information you want in that section.

f) Do one or more of the following

· To enter additional text for the header or footer, enter the text in the Left section, Center section, or Right section box.

· To start a new line in one of the section boxes, press ENTER.

· To delete a section of a header or footer, select the section that is to be deleted in the section box, and then press BACKSPACE.

6. What is a relative cell address reference? How do you change a relative reference to an absolute reference? What is a mixed cell address reference?
Relative cell address references are the default in Excel. Addresses are automatically are copied to new cells. To change a relative reference to an absolute reference, these cells must be specifically identified to the program by placing a $ sign before the part that is not to be changed. For example, we use ‘B12’ as the notation for a relative reference.

· If we want to change this relative reference to absolute reference, we use the notation of ‘$A$12’. If the position of the cell that contains the formula changes, the absolute reference remains the same. If you copy the formula across rows or down columns, the absolute reference does not adjust.

Mixed cell address references allow only the row potion or column portion of the cell reference to be adjusted.  For example, we denote it as ‘$A$3’. If you copy the formula across rows or down columns, the relative reference automatically adjusts, and the absolute reference does not adjust.
7. What is the formula bar? What is the name box?
Formula bar is a bar at the top of the Excel window that is used to enter or edit values or formulas in cells or charts. It displays the constant value or formula stored in the active cell.

Name box is a box at the extreme left of the formula bar that shows the selected cell, chart item, or drawing object.
8. What is the difference between erasing the contents of a column and deleting the column?
When erasing, we are removing the contents of the cell, leaving the cell blank. But when deleting, we are removing the whole column, and Excel will move the surrounding cells to fill the space left behind.
9. How will you freeze a part of the worksheet?
To freeze a part of a worksheet, we do one of the following:

a) To freeze panes horizontally: Select the row below where we want the split to appear.

b) To freeze panes vertically: Select the column to the right of where we want the split to appear.

c) To freeze panes both horizontally and vertically: Click the cell below and to the right of where you want the split to appear.

d) Then, on the Window menu, click Freeze Panes.
10. What is the maximum number of significant digits possible in MS Excel?

The maximum number of significant digits possible in MS Excel is 15 digits.

11. What is the difference between a bar chart and a histogram?

A bar chart is a chart where the data is presented either horizontally or vertically in bars. The bars can be drawn with space between them.

.     The Histogram analysis tool calculates individual and cumulative frequencies for a      cell range of data and data bins. This tool generates data for the number of occurrences of a value in a data set.
12. How will you put the error bars in the x-y plot? Make a table with data points along with their error values, and draw a graph with errors bars shown.  (hint: See Help facility in Excel)
a) Click the data series to which we want to add errors bars.
b) Select Selected Data Series from the Format menu.
c) On the X Error Bars tab or the Y Errors Bars, select the options we want, Change the fixed value according to our x and y value error.
[REFER TO EXCEL DOCUMENT]

13. How will you protect a workbook in MS Excel?
To protect a workbook in MS Excel is by clicking Tools( Protection( Workbook. Now all the cells which are not unlocked as above are protected from any modification.
14. How to protect only selected cells in MS Excel?
To protect only selected cells in MS Excel is clicking format( cells ( protection ( clear the unlock.
15. Explain the different forms of log functions available in MS Excel.
Log, the short for logarithm, is an exponent to which the base must be raised to produce a given number. For example; 2³ = 8

3 is the exponent to which 2 must be raised to produce 8.
3 is called the logarithm of  8 with base 2.

3 = log2 8 (base 2 is written here as a subscript)

In MS Excel, there are 2 different functions of logarithm: common logarithm (logarithm with base 10) and natural logarithm (written as ‘ln’).
Common logarithm, or decadic logarithm (here ‘deca’ means ‘ten’), is a logarithm that uses the base 10. If a certain logarithm is written without a base, it is assumed to be common logarithm. It is denoted as ‘log10 x’. It is also known as Briggsian logarithm, after Henry Briggs, a 17th century mathematician.

Natural logarithm, which was invented by John Napier, is very much different from common logarithm. It is the logarithm to the base e and is denoted as ‘ ln x’ or ‘loge x’, where e=2.718282828.. The natural logarithm is defined for non-zero complex numbers.

16. In MS Excel, the argument of the sin functions should be in radians.  Assume that you are provided with a set of angles in degrees.  Use radians function in MS Excel to express the angles in radians and then find out the sin of these functions. 
[REFER TO EXCEL DOCUMENT]

17. Use of Help facilities in Excel:  Go through the Help facilities in Excel and study several different types of functions.  Explain the application of three different uncommon functions using your own examples.
AVERAGE:this function is used to find the average (arithmetic mean) of numbers 20,40 and 60 is 40.

Average=(20+40+60)/3=40

MEDIAN:this function is used to find the number in the middle set of the given numbers. For example, the median for the numbers 7 and 9 is 8.

Median=(7+9)/2=8

ACOS: this function is used to return the arccosine of a number, in radians in the range 0 to Pi. The arccosine is the angle whose cosine is number.

Eg:0.05236(ACOS)=1.52
18. Calculation using Formulas: Select any formula (as complicated as possible)  from any one of your textbooks. Use Excel to calculate this formula, by entering the constants and the variables separately.  (For example:
i. Gas constant = … units

ii. Temperature = …. units

iii. Pressure        =  ..  units

iv. Voulme        =   formula)
Boyle’s Law:
P1V1=P2V2; where P1=initial pressure, P2=final pressure, V1=initial volume and V2=final volume.

We assume that P1=unknown, P2=200kP, V1=250m3, V2=100m3. Search for P1.

P1x250m3=200kPx100m3
      P1=200x100/(250)
          =80kP

[REFER TO EXCEL DOCUMENT]

19. Multiplot: Write down any one formula with two constants (a and b) and one variable (x). (eg. y=a sin(bx) or y=a x + b log (x) …etc).  You can also make up your own formula.  Use Excel to calculate your chosen formula for a range of x values at five different sets of constant values and tabulate them as x vs y with x in the first column and y in the next four columns as follows:
	No.
	x
	y values calculated using different set of constants

	
	
	a= …. b=…
	a= …. b=…
	a= …. b=…
	a= …. b=…

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	


Plot all the four curves in the same plot and label them differently.  Comment on the effect of the constants on these plots.

Comment about the graph: The constant a and b influence the Y values.

[REFER TO EXCEL DOCUMENT]

20.
Solving Simultaneous Equations: Write a set of five equations with five variables (eq. p, q, r, s, t and u) and solve them using Excel.  Verify your answer by back substitution.
[REFER TO EXCEL DOCUMENT]

21.
Solver exercise: The following data set is obtained in an experiment:

	R
	V

	0.5
	127.0355

	1.0
	48.0715

	1.5
	12.1348

	2.0
	8.3139

	2.1
	5.3366

	2.2
	3.1064

	2.3
	1.5361

	2.4
	0.5472

	2.5
	0.0689

	2.6
	0.0374

	2.7
	0.3957

	2.8
	1.0921

	2.9
	2.0807

	3.0
	3.3199

	3.1
	4.7728

	3.2
	10.0998

	3.5
	20.7786

	4.0
	31.9924

	4.5
	42.6319

	5.0
	52.1824

	5.5
	60.4667

	6.0
	67.4911


Use the solver module in Excel to fit the data using the equation 

V=a(1-exp(-b(R-c)))2,

where a, b and c are constants to be determined.  Use solver to determine these constants.  Calculate the V values using the values of a, b and c that you had found out by excel.  Plot the experimental and the calculated data in the same plot and label them properly.  What is the value of V at R=1.25 and R=c?

[REFER TO EXCEL DOCUMENT]

22.
Solve Van der Waals's equation: (P + a/V2)(V - b)=RT, for the volume per mole (V) of an organic compound at 10 atm pressure and 400oK. The Van der Waals's constants for this particular compound are a = 40.0 liter2 atm/mole2 and b = 0.2 liter/mole. (Hint: use Goal Seek)[REFER TO EXCEL DOCUMENT]
23.
Select any equation such as given in the above question, from any of your text books and solve it using goal seek.
[REFER TO EXCEL DOCUMENT]

24. Grades distribution: Consider a class consisting of 12 to 20 students.  Create their mark list in their final exam.   The list should contain their names and their marks in two columns. Use the nested “if condition” to determine their grades (eg. A, B ….) and list them in the third column.  Present their grade distribution as a histogram and as a pie chart.
[REFER TO EXCEL DOCUMENT]

25. Computerization of the laboratory report:  Present any of your experimental laboratory report involving detailed calculations and graphs, as an Excel workbook.  Your report should be self-contained and contain all the details to verify your graphs and results.  In short it should look as lab report that you would submit after completing your experiment.
Experiment 1
Objective: To investigate the relationship between sin θ and acceleration.

[REFER TO EXCEL DOCUMENT]

Acceleration, a= mg sin θ

Mass, m= 2 kg

Gravity, g= 9.8 Nms-1
26. Exercises done in the computer lab: Present a complete report of all the excel exercises done during the lab hours.  
[REFER TO EXCEL DOCUMENT]

General instructions for exercises in Excel  (Read these instructions carefully)

For maximum credits, use as many Excel options as possible.  Fit all the information within the screen size.  If it is more than a screen size use the next worksheet and name them creatively.  All the worksheets should be self explanatory with appropriate tiles and explanations.  In all the MS Word documents use the view and header/footer option to automatically include the name, date and time of the file while printing the documents.  In all the worksheets use the page setup and header/footer option to automatically include the name, date and time of the file while printing the excel worksheets.  Protect your workbooks (refer the last slide of my Excel presentation or Help in Excel) using the name of the file as the password.  All the information except the information to be input by the users should be locked.  


After you have completed each assignment put all the files (virus free) in a single folder, compress them using winzip and email (ibrahiman@iiu.edu.my) the final zipped file to me.  All of your assignments should carry Assignment no, due date of the assignment, your name, matric card no, section no., degree program name, email address and the web page address of the assignment.  The name of the final zipped file should have the form 1mohd.zip, where 1 refers to assignment number and mohd refers to your name.  Send both the printed and the electronic versions of your assignments before the due date.  Once you have built your home page you should publish your assignments in your home pages.  For evaluation purposes, the date of submission of the printed version would be taken as the correct submission date.   All of your assignments should have complete particulars (inside the files) such as the course name, assignment number, due date, submission date, your name, your degree program, student ID number, section number, your email address, home page address, instructors name, questions and answers. Any form of copying is completely prohibited.

Each assignment will be graded using the following scheme:

Submission on or before the due date 
2 marks (ZERO marks for late submission)

Follow the instructions as above 

2 marks

Answer all the questions 


2 marks

Originality, creativity and critical analysis
4 marks






Total
10 marks

Nadirah binti Sulaiman
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